This document has been prepared by Cedara Software Corp. for its customers. The content of this document is confidential. It may be reproduced only with written permission from Cedara Software Corp. Specifications contained herein are subject to change, and these changes will be reported in subsequent revisions or editions.

It is prohibited to use the software described in this document as a substitute for the knowledge, skill and experience of the competent medical personnel who are its intended users.

_Cedara I-Response™ for NIH_ is a trademark of Cedara Software Corp. The names of other products mentioned in this document may be the trademarks or registered trademarks of their respective companies.

The _Cedara I-Response™ for NIH_ application is intended for research purposes only.

Copyright © 2008 by Cedara Software Corp. All rights reserved. Unauthorized use, reproduction, or disclosure is prohibited.

Cedara Software Corp.
6509 Airport Road, Mississauga, ON, Canada L4V 1S7
Tel: +1-905-672-2100 • Fax: +1-905-672-2307
Toll-free in North America: 1-800-724-5970

For assistance, please contact National Cancer Imaging Archive (NCIA) Customer Support:

• In North America, call 301-451-4384 or toll-free 1-888-478-4423

• Email ncicb@pop.nci.nih.gov

Part Number 2008-01466 Rev 1.0
Chapter 1: Overview

About the Application ................................................................. 1
Safety Precautions ................................................................. 2
  Repetitive Strain Injury ......................................................... 2
  Lossy Compressed Images .................................................. 2
  Date and Number Format. .................................................... 3
  Power and Hardware Failure ................................................ 3
  Magnetic Interference ......................................................... 4
  Studies with Contrast ......................................................... 4
  Computer Virus Protection ................................................ 4
Customer Support ................................................................. 5
About this Guide ................................................................. 5
  Visual Cues ........................................................................ 5
  Notes, Cautions, and Warnings ........................................... 6

Chapter 2: Installing the Cedara I-Response for NIH Application

Workstation Requirements ....................................................... 7
Supported Operating Systems .................................................. 8
Installing the Application ....................................................... 8
  Configuring the Application Port ......................................... 13
Uninstalling the Application .................................................. 14
Upgrading the Application .................................................... 15

Chapter 3: Getting Started

Starting the Application ......................................................... 17
Using the Help System ......................................................... 18
Exiting the Application ....................................................... 18
# Chapter 4: Selecting and Loading Patient Studies

- Accessing the Online Study List .................................................. 19
- Sample Study List Columns ...................................................... 20
- Selecting and Loading Studies for Review .................................. 21

# Chapter 5: Using the Main Review Window

- Using the Review Toolbar ......................................................... 25
- Using the Popup Menu to Access Lesion Analysis and Review Tools ........ 25
- Using the Thumbnails .............................................................. 26
- Selecting Other Studies from the Sample Online Study List ............... 27
  - Viewing Patient Information .................................................. 27
- Using the Three-Button Mouse or Mouse Wheel ............................ 28

# Chapter 6: Using the Viewing Protocols

- Understanding the Viewing Protocols ....................................... 30
- Selecting the Viewing Protocol .................................................. 30
- 2D Lesion Viewing Protocol ...................................................... 31
  - Changing the Layout in 2D Lesion Viewing Protocol .................... 31
  - Scrolling through Images in 2D Lesion Viewing Protocol ............. 33
  - Synchronized Scrolling in 2D Lesion Viewing Protocol ............... 34
- 2D & MPR Lesion Viewing Protocol .......................................... 36

# Chapter 7: Using the Lesion Analysis Tools

- Working with Graphic Layers .................................................... 37
- Selecting Layers ........................................................................ 38
- Deleting Graphic Elements in Layers .......................................... 39
- Showing or Hiding Graphic Elements .......................................... 40
- Understanding Markup Management ...................................... 41
  - Using Markup Management as a Read-write User ....................... 43
  - Using Markup Management as a Read-only User ...................... 44
- Measuring Lesions .................................................................... 45
Chapter 8: Using the Review Tools

Correlating the 2D & MPR Viewing Protocols .................................................. 66
Changing the MPR Properties ................................................................. 67
Changing the Position of the Cross-Reference Lines ........................................ 69
Changing the Window Settings ................................................................. 70
  Defining Window Presets ........................................................................ 72
Zooming Images ....................................................................................... 74
Panning Images ......................................................................................... 75
Changing the Scope .................................................................................. 75
Magnifying Images .................................................................................... 76
Editing Measurements .............................................................................. 77
  Editing RECIST, Crosshair and Non-target Measurements ....................... 77
  Editing Contour Measurements ................................................................ 79
Querying the Density and Standard Uptake Value (SUV) ............................... 80
Changing the Text Level ........................................................................... 81
Changing the Color Palette ...................................................................... 82
Chapter 1: Overview

This user’s guide is designed to introduce you to the main Cedara I-Response for NIH application functions. Each chapter provides easy, step-by-step instructions to help you use the application. Wherever possible, the illustrations reflect the application’s standard configurations.

About the Application

The Cedara I-Response for NIH application provides sophisticated image manipulation and tumor tracking functionality as well standard image review tools. Since measurements are acquired and tracked over multiple studies (i.e., pre and post treatment), you can use this data to assist you when evaluating the results of treatment therapy or disease progression. The application allows you to track and record tumor response by measuring lesions according to Response Evaluation Criteria in Solid Tumors Group (RECIST), World Health Organization (WHO) response criteria, and total volume calculations.

Caution: The application presents patient studies on a monitor in various ways. It does not interpret image data to generate a diagnosis. Diagnostic interpretation is the user’s responsibility.

Note: The Cedara I-Response for NIH application is intended for research purposes only.
Safety Precautions

This section contains a list of safety precautions that you must be aware of when using the Cedara I-Response for NIH application.

Repetitive Strain Injury

As with all computer systems, there is a risk of repetitive strain injury if the workstation is used excessively. Repetitive strain injury can include symptoms such as eyestrain, backache, and so on.

**WARNING:** Excessive use of the workstation may result in repetitive strain injury.

Lossy Compressed Images

It is possible to misinterpret images that are lossy compressed due to the loss of information from the image. To avoid misinterpretation, the application labels all images that are lossy compressed.

**Caution:** Lossy compressed images are subject to misinterpretation due to information loss. Lossy compressed images must not be used for primary diagnostic interpretation unless approved for use.
Date and Number Format

The application uses the date format and number format specified by your workstation’s regional settings. You should check your regional settings to ensure that your workstation uses the most common date and number format used in your region to avoid confusion. We also recommend that you set the workstation to recognize four-digit years.

> To check your workstation’s regional settings

1. In the Taskbar, click Start, Settings then select Control Panel.
2. Double-click Regional and Language Options or Regional Settings (as appropriate).
3. Ensure that you have selected the most common language, number, and date settings used in your region. The date style should include a four-digit year.
4. If you have made any changes, restart your operating system.

Power and Hardware Failure

Due to uncontrollable events such as power and hardware failure, the workstation must not be the only source of image data for diagnosis. Image data must be available from other sources such as scanner consoles, archives, and/or films.

---

Caution: The workstation must not be the only source of diagnostic image data.

---

Image data can be lost if the workstation is shut off abruptly while a study is being transferred to the hard drive (e.g., there is a power failure or the workstation is accidentally unplugged). The application may display the message "No Image - check manual" when you load the study for review. In this case, you must delete the study and transfer it again.

---

Caution: We recommend that you install an Uninterruptible Power Supply (UPS) to support the workstation in the event of power failure.
Magnetic Interference

The images displayed on the workstation’s monitor(s) can be distorted by strong magnetic fields; therefore users should consult the OEM’s recommendations concerning placement of electronic equipment in proximity to the workstation.

Caution: Position the workstation according to the OEM's recommendations on placement of electronic equipment.

Studies with Contrast

There is a contrast field on many MR and CT scanners where the type and amount of contrast can be entered. Due to the way in which DICOM (Digital Imaging Communications in Medicine) fields are interpreted by the application, this field must be complete for the application to recognize that the study was acquired with contrast. If you want the application to recognize the study as one that was acquired without contrast, leave the field blank.

Caution: On many MR and CT scanners, the type and amount of contrast must be entered in the contrast field. If the field is left blank, the application will indicate that the study was acquired without contrast.

Computer Virus Protection

Computer viruses can prevent the application from working properly. We recommend you protect the workstation with anti-virus software. Contact your System Administrator for further details.

Caution: We recommend that you install anti-virus software on your workstation.
Customer Support

For applications support, please contact National Cancer Imaging Archive (NCIA) Customer Support:

- In North America, call 301-451-4384 or toll-free 1-800-668-7990
- Email ncicb@pop.nci.nih.gov

About this Guide

This user’s guide assumes that you are familiar with the basic operation of personal computers, such as how to turn them on, how to use the mouse, and how to work in the Microsoft Windows Operating System environment. If you are not familiar with these operations, please refer to the documentation provided with your workstation.

Visual Cues

- Words shown in large, boldface text, such as Done, indicate buttons and tools that can be clicked with the mouse.
- Words shown in regular, boldface text, such as exit, indicate characters that you must type into the keyboard exactly as they appear (i.e., if you are instructed to type exit, you should type the characters exactly as they are printed).
- Words shown in uppercase, such as ENTER, indicate keys on the keyboard that should be pressed. If several keys appear together separated by hyphens (e.g., CTRL+ALT+DEL), it means that you should press all three keys simultaneously.
- Words shown in italics are used for emphasis.
Notes, Cautions, and Warnings

**Note:** Notes are used to indicate information which may be helpful or of special interest to the reader.

**Caution:** Caution messages indicate procedures which, if not observed, could result in loss of data on the hard disk or damage to the equipment. Do not proceed beyond a Caution message until the indicated conditions are fully understood and met.

**WARNING:** Warning messages indicate procedures or practices which, if not observed, could result in personal injury to the user or the patient. Do not proceed beyond a WARNING message until all of the indicated conditions are fully understood and met.
Chapter 2: Installing the Cedara I-Response for NIH Application

This chapter describes how to install the Cedara I-Response for National Institute of Health (NIH) application.

It is intended to be used by service personnel who have a working knowledge of the Microsoft® Windows® operating systems. Please consult the appropriate Microsoft documentation before using this guide if you are not familiar with Microsoft® Windows® operating systems.

Workstation Requirements

The application runs on a workstation that normally consists of a personal computer, keyboard, mouse, and one monitor. You can use a two-button mouse, a three-button mouse, or a wheel mouse. The middle button on the three-button mouse and the wheel button on the wheel mouse have specific functions that are described in the appropriate sections of this user’s guide.

A workstation that is intended to be used in a clinical environment should meet the recommended requirements.

It is important to note that these requirements are only a guideline. Each installation will have different requirements based on the types of images being viewed, the number of images being viewed, as well as other considerations, such as the operating system services which may be running in the background.

WARNING: Use only workstations that have the proper electrical certification.
To avoid system overload caused by resource contention, we recommend you do not install any other graphic intensive applications on the workstation.

Table 2-1: Cedara I-Response for NIH Workstation Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Recommended Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel® Xeon™ 3.2 GHz</td>
</tr>
<tr>
<td>Memory</td>
<td>2 GB RAM</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>40 GB</td>
</tr>
<tr>
<td>Video Card</td>
<td>Any modern video card</td>
</tr>
<tr>
<td>Monitor</td>
<td>One 19” (or larger) CRT or flat panel color monitor.</td>
</tr>
<tr>
<td>Network Interface Card</td>
<td>10/100/1000 BaseT</td>
</tr>
</tbody>
</table>

When upgrading the system, the first item to upgrade is memory. Displaying and manipulating highly detailed images is a memory intensive operation; therefore, the system requires plenty of on-board system memory (i.e., RAM), as well as a high quality video card which has sufficient VRAM (i.e., video RAM).

Supported Operating Systems

You can install the *Cedara I-Response for NIH* application on the Microsoft® Windows® XP Professional and Microsoft® Windows® Vista operating systems with Service Pack 2.

Installing the Application

The following section describes how to install the *Cedara I-Response for NIH* application. This section also describes how to configure the application’s default port.

> To install the application

1. Shut down all other applications running on the workstation, including any third-party antivirus or utility applications (e.g., Norton AntiVirus®, Microsoft Windows AntiSpyware).
2. In Windows Explorer, navigate to the folder where you saved the Setup.exe file. Double-click Setup.exe.

3. Click **OK** to confirm that you want to install the application.

4. At the Welcome dialog box, click **Next**.
5. In the Customer Information dialog box, type the appropriate name and organization in their respective fields, then click **Next**.
6. In the Select Installation Folder dialog box, do the following:

- Click **Browse...** to select the destination folder to install the application. The system displays the default destination folder for the installation files.

- Select the “Everyone” radio button if you want every user that logs onto the workstation to have access to the application. If you select the “Just me” radio button, only the user currently logged on to the workstation can access the application.

- Click **Next**.
7. Click **Next** to install the application.

8. The Setup Wizard begins to install files and displays a progress bar indicating the progress of the installation.
9. After the installation is complete, click **Close**.

10. At the Setup succeeded dialog box, click **OK**.

### Configuring the Application Port

By default, the application uses port 8889 to communicate with the Web server. If you need to change the application's port number, use the following procedure.

> **To configure the port number**

1. On the Desktop, right-click the **I-Response** shortcut and select **Properties**.

2. In the Target field, replace the default port number (8889) with the desired port number.

3. Click **Apply** then **OK**.
Uninstalling the Application

This section describes how to remove the Cedara I-Response for NIH application files from your computer.

**Caution:** When you uninstall the application, all of the application files are removed, including the configuration files, registry settings and license files.

> To remove the application files

1. Open the Control Panel.
2. Double-click **Add or Remove Programs**.
3. In the list of currently installed programs, click Cedara I-Response NIH.
4. Click **Remove**.
5. Click **Yes** to remove the application.
6. The system displays a progress bar while it uninstalls the application.
Upgrading the Application

This chapter describes how to upgrade the application from your current version to Cedara I-Response for NIH 2.0.

> To upgrade the application

1. If the Cedara I-Response for NIH application is running, close it.

2. Uninstall your existing Cedara I-Response for NIH application (see “Uninstalling the Application” on page 14).


4. Follow the on-screen instructions as described in “Installing the Application” on page 8.
Chapter 3: Getting Started

This chapter briefly describes how to start the application. It also describes how to use the help system and how to exit the application.

Starting the Application

Use the following procedure to start the application.

> To start the application

1. Start the workstation.
2. When you are prompted to log on, press CTRL-ALT-DEL.
3. In the Enter Network Password dialog box, type your user name and password.
4. Click OK.
5. To open the application, do one of the following:
   - In the Taskbar, click Start, Programs, Cedara Software, I-Response.
   - On the Desktop, double-click the I-Response NIH icon.

Note: For details on using the sample online Study List, see “Selecting and Loading Patient Studies” on page 19.
Using the Help System

The online help system provides quick access to user instructions.

> To use the online help

1. From the Help menu, select Contents.
2. The application displays the online help in a separate window.
3. Use the following features to navigate the help system and find the required topics:
   - Click Contents to display a list of topics available, then double-click the topic you want to view.
   - Click Index to display a list of keywords from which you can select a topic. Type in the first few letters of the keyword you are looking for, then double-click the keyword. This is often the easiest way to find a topic.
   - Click Search to find all topics that contain a keyword. Type the keyword you want to find, click List Topics, then click the desired topic in the list displayed.
   - Click Back to return to the last topic viewed.

Exiting the Application

This section describes how to exit the Cedara I-Response for NIH application.

> To exit the application

1. From the File menu, select Exit.
2. When the application asks if you really want to quit, click Yes.
3. The application closes and returns you to the desktop.
Chapter 4: Selecting and Loading Patient Studies

This chapter discusses selecting and loading patient studies for review.

The application uses an online Study List to display patient studies. The online Study List resides independently from the local application in a web-based environment. User authentication is required to access patient studies.

Note: For the purposes of this User’s Guide, a sample online Study List is depicted. It is not intended to replicate the online Study List environment used by NIH.

Accessing the Online Study List

Accessing the online Study List requires a username and password, and determines what application tools are available for use. The availability of some of the application’s tools is driven by user permissions in order to prevent their use by unauthorized persons. The appearance, or non-appearance of certain menu items depend on what type of permissions you have. For more information on the application’s user permissions features, see “Understanding Markup Management” on page 41.

Use the Log on feature provided to log on to the Online Study List to view patient studies and use the application’s available tools.

[Diagram of Log On Feature] Log in to view patient studies and use the application's tools
After successfully logging on, the online Study List displays as represented by the sample below.

Sample Study List Columns

The columns in the sample online Study List above provide patient study and series information described in Table 4-1.

Table 4-1: Sample Study List Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Name</td>
<td>The patient’s name</td>
</tr>
<tr>
<td>Study Date</td>
<td>The date the study was created</td>
</tr>
<tr>
<td>Series Number</td>
<td>The total number of series (i.e., acquisitions) in the study</td>
</tr>
</tbody>
</table>
Selecting and Loading Studies for Review

You can select, load and depending on the type of permissions you have, use the following tools to analyze and review patient studies in the application’s Main Review window (see "Using the Main Review Window" on page 23):

• Lesion Analysis Tools — Measure lesions and define regions of interest (ROI) using the Contours, RECIST, Crosshair and Non-target tools to compare lesions over time. For more information on using the Lesion Analysis tools, see “Using the Lesion Analysis Tools” on page 37.

• Review Tools — Perform standard image review tasks (i.e., zoom and pan images). For more information on using the Review tools, see “Using the Review Tools” on page 65.

WARNING: To ensure optimal clarity, the application loads low fidelity images progressively and displays the label “Downloading in progress” until the image has finished loading. Diagnosis should not be performed while the download is in progress. If the image is compressed, the Lossy Compressed label and compression ratio displays throughout the download.

Note: You cannot load studies from more than one patient. If you load multiple studies, ensure they belong to the same patient. Otherwise, the application displays an error message and prevents you from loading the studies.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series Description</td>
<td>The image views</td>
</tr>
<tr>
<td>Instance</td>
<td>The instance number</td>
</tr>
<tr>
<td>Modality</td>
<td>The source modality of the study</td>
</tr>
<tr>
<td>X</td>
<td>The study selection column</td>
</tr>
</tbody>
</table>
Chapter 5: Using the Main Review Window

Loaded images are displayed in the Main Review window. This chapter describes the features of the Main Review window which consists of the Review Toolbar, and popup menu.

The Main Review window also includes:

- the Lesion Group Box (see “Using the Lesion Analysis Tools” on page 37);
- the Graphics Layers Group Box (see “Working with Graphic Layers” on page 37);
- the MPR Properties Group Box (see “Changing the MPR Properties” on page 67); and
- The Synchronized Scroll Bar (see “Synchronized Scrolling in 2D Lesion Viewing Protocol” on page 34).

Note: For information on viewing modes, see “Using the Viewing Protocols” on page 29.
The example below displays the Main Review window.

Caution: The Main Review window displays two types of error messages; rendering server errors display in the Status Bar and application errors display as popup dialogs.
Using the Review Toolbar

The Review Toolbar provides the main access to the application’s review tools. As with all Windows applications, you can access some of the functions from the main menus in the menu bar. Some of the more frequently used tools are also available from the popup menu (see “Using the Popup Menu to Access Lesion Analysis and Review Tools” on page 25).

Note: You can expand the Review Toolbar to access hidden review tools. To expand the Review Toolbar, click the Toolbar Options button.

Using the Popup Menu to Access Lesion Analysis and Review Tools

As with most Windows applications, you can right-click a window (i.e., image within a viewport) to access a popup menu. Depending on your user permissions, the popup menu provides access to the application’s Lesion Analysis tools and common review tools. For information on user permissions, see “Understanding Markup Management” on page 41.

> To use the popup menu

1. Right-click any viewport and select the appropriate option from the popup menu.
2. The application dismisses the menu and performs the operation. If you select one of the review tools (e.g., **Window/level Presets**), the application changes the function of the left mouse button to the selected tool and remains set to that function until you select a different tool. The function of the left mouse button is indicated by the pointer. For example, if the left mouse button is set to Window level, the mouse pointer appears as shown here. For information on using all of the applications review tools, see “Using the Review Tools” on page 65.

---

**Using the Thumbnails**

Thumbnails represent the series currently loaded. They allow you to track which series are currently displayed and provide a quick means of navigation when more than one series is loaded. In addition to navigation, thumbnails provide basic study information such as the date and series description. The application displays thumbnails if you load a study that contains one or more series, or if you load more than one study for the same patient. Each thumbnail displays one image from the series it represents. The series description is displayed when you hover over the thumbnail as shown in the example below. The green border indicates the series that is currently being displayed.
Selecting Other Studies from the Sample Online Study List

When you finish reviewing the current study, you can return to the sample online Study List to access additional studies for review.

**Note:** To access the sample online Study List, see “Accessing the Online Study List” on page 19.

Viewing Patient Information

You can access in-depth patient study information while in the Main Review window.

> **To view the patient’s information**

1. In the Review Toolbar, click **Patient Information**.
2. The application displays the Patient Information dialog box.

3. Use the scroll bars to view all of the available information.
4. Using the Patent Information dialog box, you can:
   - click the **Group Attributes** button to sort by group,
   - click the **Save to File** button to save patient information;
   - click the column headers to sort on Name, Tag or Value; and
   - enter text in the Filter field to filter on Name, Tag or Value.

5. When you are finished, click **Close**.

---

**Using the Three-Button Mouse or Mouse Wheel**

If you have a three-button mouse or a mouse-wheel, you can use the mouse to perform specific review tool functions. The three-button mouse and mouse-wheel actions are described in various procedures in “Using the Review Tools” on page 65.
Chapter 6: Using the Viewing Protocols

The application supports two viewing protocols which are invoked when you load two or more lesion series into the Main Review window for comparison. Each viewing protocol is optimized for the type of image being loaded and the real estate comprising your monitor.

This chapter describes the following two viewing protocols:

- 2D Lesion (see “2D Lesion Viewing Protocol” on page 31)
- 2D & MPR Lesion (see “2D & MPR Lesion Viewing Protocol” on page 36)

Note: The application does not support multi-phase or multi-frame data.
Understanding the Viewing Protocols

This section describes the 2D Lesion and 2D & MPR Lesion viewing protocols supported by the application.

Table 6-1: Understanding the Viewing Protocols

<table>
<thead>
<tr>
<th>Views available when you load...</th>
<th>Views</th>
<th>Viewports</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2D View</td>
<td>2D MPR Lesion View</td>
</tr>
<tr>
<td>one 2D image series</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>two 2D image series</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>one 3D image series</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>two 3D image series</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>two series (one is not a 3D image series)</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Note: The criteria that determines if a series is 3D renderable includes any modality except CR and DR with more than four slices, and has the correct DICOM acquisition properties based on the OpenEyes Toolkit rules.

Selecting the Viewing Protocol

Use the following procedure to select the required viewing protocol.

> To select a viewing protocol

1. From the View menu, select the required viewing protocol from the dropdown menu.

2. The application switches the viewing protocol and displays the images.
2D Lesion Viewing Protocol

The 2D Lesion viewing protocol provides a conventional approach to viewing images. In this view, the images are displayed in their original acquisition plane.

When you load other modalities (e.g., MR) into the 2D Lesion viewing protocol, the application displays the images in the 1x1 layout (i.e., one viewport) by default; however, you can manually change the layout (see “Changing the Layout in 2D Lesion Viewing Protocol” on page 31). The example below illustrates 2D Lesion viewing protocol in 2x2 layout when you load an MR study.

Changing the Layout in 2D Lesion Viewing Protocol

The image layout specifies the number of rows and columns in which the images are displayed on a monitor. Each image area is referred to as a viewport. For example, if you select a 2x2 layout, there are four viewports.
> To change the image layout

1. In the Review Toolbar, click the Layout button and select one of the predefined image layouts (e.g., 2x2).

2. The application displays the 2D images in the selected layout.
Scrolling through Images in 2D Lesion Viewing Protocol

The application provides several standard methods of scrolling through images in 2D Lesion viewing protocol. You can:

- scroll using a three-button mouse;
- scroll using the vertical scroll bar; and
- scroll using the keyboard.

**Note:** For information on synchronized scrolling in the 2D Lesion Viewing Protocol, see “Synchronized Scrolling in 2D Lesion Viewing Protocol” on page 34.

**Note:** For information on melting through images using the mouse-wheel, see “To melt through the images using the mouse-wheel” on page 70.

> **To scroll using a three-button mouse**

1. Load and display the required 2D Lesion series (see “Selecting and Loading Studies for Review” on page 21).

2. Middle-click any viewport and with the mouse button pressed:
   - drag the mouse pointer up to scroll backward through the images; or
   - drag the mouse pointer down to scroll forward through the images.

> **To scroll using the vertical scroll bar**

- scroll up to scroll backward through the images; or
- scroll down to scroll forward through the images.

> **To scroll using the keyboard**

- press the UP-ARROW key to scroll backward through the images; or
- press the DOWN-ARROW key to scroll forward through the images.
Synchronized Scrolling in 2D Lesion Viewing Protocol

Synchronized scrolling allows you to scroll images in two viewports at the same time. When one viewport is scrolled, the second viewport scrolls in equal increments, i.e., by the same number of images. You can anchor synchronization by locking an arbitrary image in each viewport.

> To synchronize scrolling

1. Load and display two 2D Lesion series (see “Selecting and Loading Studies for Review” on page 21.

2. In the review Toolbar, click Link Viewers.

3. Using the vertical scroll bar in either viewport:
   - scroll up to scroll backward through the images; or
   - scroll down to scroll forward through the images.
4. The application scrolls images in both viewports simultaneously.

Note: You can anchor synchronized scrolling by locking an arbitrary image in each viewport.

Note: If an image in one viewport cannot be aligned with an image in another viewport, the latter viewport will not advance; rather, a message displays stating “Not Linked”.

---

**Manual scrolling in active viewport**

**Synchronized scrolling in inactive viewport**

**Synchronized scrolling in inactive viewport**

**Manual scrolling in active viewport**
2D & MPR Lesion Viewing Protocol

2D & MPR Lesion viewing protocol allows you to display multi-planar reformat (MPR) views of images. This allows you to view a patient’s series in multiple orthogonal planes. For example, if the original acquisition plane was axial, MPR allows you to view the images in the coronal and sagittal planes. This is useful since planes orthogonal to the acquisition plane can be more appropriate for evaluating structures of interest.

The following are prerequisites for viewing images in this view:

- The series must contain at least four images.
- The images in the series must have been acquired in the same orientation, at the same angle and at the same table height.

**Note:** For information on adjusting the MPR properties see “Changing the MPR Properties” on page 67.

The example below depicts 2D & MPR Lesion viewing protocol displaying Axial, Sagittal and Coronal orthogonal planes.
Chapter 7: Using the Lesion Analysis Tools

The application’s Lesion Analysis tools help you track, compare and record tumor development by:

- creating graphic layers to save, edit and delete graphic elements (e.g., lesion measurements and labels); and
- measuring lesions and defining regions of interest using the Contours, RECIST, Crosshair and non-target and tools.

**Note:** To change the image display parameters (e.g., window settings, zoom, pan), see “Using the Review Tools” on page 65.

**Note:** We recommend that you use MR and/or CT data to perform Lesion Analysis.

---

Working with Graphic Layers

The application allows you to create and save graphic elements (e.g., lesion measurements and labels) in separate graphic layers. You can create graphic elements in up to seven predefined graphic layers. Each layer can contain multiple graphic elements.

The application displays all graphic layers at the same time; however, you can show or hide graphic elements within each layer. When working with graphic layers, you can edit the graphic elements on one layer without affecting any of the other layers. Graphic elements on the active layer are displayed in orange. Graphic elements on the inactive layer are displayed in blue.

You can also view graphic elements created by other users.

**Note:** For details on using the NT (non-target) layer, see “Using the Non-target Tool” on page 56.
The following example displays contours and crosshair measurements drawn on two series using two graphic layers.

Selecting Layers

To create graphic elements on different layers, you must first select the active layer. Use the following procedure to select the active layer.

Note: If you are loading a series for the first time, application selects the Tumor layer by default. If you are loading a series with previously saved graphic elements, the application selects the last saved layer.

Note: Make sure you save your changes for the current active layer before selecting a new active layer.
> To select an active layer

1. In the Graphic Layers group box, select the appropriate layer from the Layer dropdown list.

2. Create or edit graphic elements as required.

3. In the Graphic Layers group box, click Save.

Deleting Graphic Elements in Layers

Use the following procedure to delete all graphic elements in a layer.

**Note:** You cannot edit or delete graphic elements created by other users, see “Understanding Markup Management” on page 41.

> To delete all graphic elements in a layer

1. In the Graphic Layers group box, select the appropriate layer from the Layer dropdown list.

2. Click Clear.

3. When the application asks if you want to delete the graphics in the selected layer, click OK.
4. In the Graphic Layers group box, click **Save**.

**Showing or Hiding Graphic Elements**

You can show or hide the graphic elements created by any user within each graphic layer.

**Note:** You cannot hide the graphic elements in the active layer.

> **To show or hide a graphic element**

1. In the Graphic Layers group box, select the **Visibility** tab.
2. From the Layer dropdown list, select the appropriate layer.
3. Do one of the following:
   - To hide graphic elements, clear the checkbox beside the corresponding user name.
   - To show graphic elements, select the checkbox beside the corresponding user name.
Note: When you show or hide graphic elements, those created in the NT layer along with the corresponding user name (under the Visibility tab), always remain visible. For example, if you select the Tumor layer, the user name which corresponds to graphic elements created in the Tumor layer is also visible. In addition, the user name which corresponds to graphic elements created in the NT layer also remains visible. If you clear the user name which corresponds to the Tumor layer, the graphic elements are no longer visible. If you clear the user name which corresponds to the NT layer, the graphic elements become inactive (blue), but remain visible. For information on graphic elements created in the NT layer, see “Using the Non-target Tool” on page 56. For information on the application’s user roles, see “Understanding Markup Management” on page 41.

Understanding Markup Management

The application’s Markup Management feature provides user account control in order to manage the information (i.e., graphic elements) other users can view. Authentication is based on the user name and password you use to log on to the online Study List, and determines which applications tools are available for use. User accounts can be assigned the following permissions:

- **Read-write** — You can create, edit, delete and save your own markups (i.e., graphic elements). You can view, but cannot edit markups created by other read-write users.
- **Read-only** — You cannot create, edit or save markups (i.e., graphic elements). You can view, but cannot edit markups created by other read-write users.
The table below displays which application tools are available to read-write users and which application tools are available to read-only users.

**Table 7-1: Understanding Markup Management**

<table>
<thead>
<tr>
<th>Tools available if you are a...</th>
<th>Tools</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lesion Analysis</td>
<td>Review</td>
</tr>
<tr>
<td>Read-write user</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Read-only user</td>
<td></td>
<td>✔</td>
</tr>
</tbody>
</table>

**Note:** For information on using the Lesion Analysis tools, see “Measuring Lesions” on page 45. For information on using the Review tools, see “Using the Review Tools” on page 65.
Using Markup Management as a Read-write User

The following procedure describes how to use the Markup Management feature as a read-write user.

> **To use Markup Management as a read-write user**

1. Log on to the online Study List using your user name and password (“Accessing the Online Study List” on page 19).

2. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

3. The application displays your user name in the Graphic Layers group box User field.

   ![Current read-write user](image)

4. From the Layer dropdown list, select the required layer (see “Selecting Layers” on page 38).

5. Create markups as required (see “Measuring Lesions” on page 45).

6. Click **Save**.

7. The application prompts you to save your markups.

8. Click **OK**.

9. To show/hide markups from other users, select the **Visibility** tab from the Graphic Layers group box and select/clear the appropriate user checkbox (see “Showing or Hiding Graphic Elements” on page 40).

10. The applications displays markups created by the selected user.
Using Markup Management as a Read-only User

The following procedure describes how to use the Markup Management feature as a read-only user.

> To use Markup Management as a read-only user

1. Log on to the online Study List using your username and password (“Accessing the Online Study List” on page 19).

2. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

3. The application displays your user name in the Graphic Layers group box User field, and disables Contours, RECIST, Crosshair and Non-target tools from the Review toolbar and the popup menu.

4. From the Layer dropdown list, select the required layer (see “Selecting Layers” on page 38).

5. To show/hide markups from other users, select the Visibility tab from the Graphic Layers group box and select/clear the appropriate user checkbox (see “Showing or Hiding Graphic Elements” on page 40).

6. The application displays markups created by the selected user.
Measuring Lesions

Lesions are categorized as target (i.e., measurable) or non-target (i.e., non-measurable). The application’s Lesion tools calculate measurements taken on multiple images in multiple series, then displays them in the Measurements Results Table for comparison. When you use the Lesion tools, you are calculating the development of tumors using the following target and non-target response criteria:

- Volume (see “Using the Contours Tool” on page 46)
- RECIST (see “Using the RECIST Tool” on page 52)
- WHO (see “Using the Crosshair Tool” on page 54)
- Non-target (see “Using the Non-target Tool” on page 56)

**WARNING:** After you create a measurement, it is possible to move it. When reading measurements, always ensure the measurement is associated with the correct geometry.

**WARNING:** The label “Uncalibrated” displays on all CR and DR modality images that are uncalibrated. If images are uncalibrated, the unit of measurement is in pixels. If images are calibrated, the unit of measurement is in millimeters. If images are a combination of calibrated and uncalibrated images, the unit of measurement is undefined.

**Note:** In order to save your measurements, you must create and save them in a graphic layer, see “Working with Graphic Layers” on page 37.

**Note:** To edit measurements, see “Editing Measurements” on page 77.
Using the Contours Tool

This section describes how to use the Contours tool. When you use the Contours tool, you are measuring the tumor’s total volume. The Contours tool calculates volumetric measurements taken on multiple images in multiple series then displays them in the Measurements Results Table for comparison. You can also export volume measurements to a local data source (see “Exporting Measurements” on page 60).

The application provides three methods for creating contours around a region of interest (ROI). You can:

• manually create contours using the Freehand tool;
• automatically create contours using the Segment tool; and
• propagate contours from one image to another in the same series.

Note: To edit contours, i.e., delete, show/hide contour measurements or edit the contour number, see “Editing Contour Measurements” on page 79.

Note: If your permissions to use the Cedara I-Response for NIH application are “read only”, you will not be able to create, edit or save contours, see “Understanding Markup Management” on page 41.

Manually Creating Contours

Use the following procedure to draw a freehand contour.

Caution: To copy contours, you must use images with the same matrix size. For information on copying contours, see “Propagating Contours” on page 51.
To manually create a contour

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Do one of the following:
   - In the Review toolbar, click the Contours button and select **Freehand** from the dropdown list.
   - Right-click the active viewport and select **Contours, Freehand** from the popup menu.

3. In the first series, click and drag the mouse to draw a contour around the ROI.

4. The volume measurements for each contour created on the active layer automatically display in the Measurements Results Table. Measurements are itemized according to diameter (X value), perpendicular (Y value) and height (Z value). Position represents the spatial position of the image at the time of acquisition.

5. Repeat **Step 3** to draw additional contours on the second series.
6. If desired, use the Active Layers dropdown list to draw contours on a different layer (see “Working with Graphic Layers” on page 37).

The example below displays volume measurements created using Freehand contours in two series in 1x2, 2D Lesion View, in two graphic layers.

7. Click **Save**.

8. The application prompts you to save your markups.

9. Click **OK**.
Chapter 7: Using the Lesion Analysis Tools

Automatically Creating Contours

Use the following procedure to create a contour automatically using the Segment tool.

> To automatically create a contour

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Do one of the following:
   - In the Review toolbar, click the Contours button and select Segment from the dropdown list. The mouse pointer displays as shown here.
   - Right-click the active viewport and select Contours, Segment from the popup menu.

3. In the first series, click and drag the mouse to segment the ROI.

4. The application automatically creates the contour which defines the tumor.
5. The volume measurements for each contour created on the active layer automatically display in the Measurements Results Table. Measurements are itemized according to diameter (X value), perpendicular (Y value) and height (Z value). Position represents the spatial position of the image at the time of acquisition.

6. Repeat Step 3 to segment additional ROIs on the second series.

7. If desired, use the Active Layers dropdown list to draw contours on a different layer (see “Working with Graphic Layers” on page 37).

The example below displays volume measurements created using Segment contours in two series in 1x1, 2D Lesion View, in two graphic layers.

8. Click Save.

9. The application prompts you to save your markups.
10. Click **OK**.

**Note:** For optimal results, adjust the Window/Level Settings accordingly then draw a line over the longest portion of the ROI, see “Defining Window Presets” on page 72.

## Propagating Contours

Use the following procedure to automatically copy a contour to subsequent images within the series.

> **To propagate a contour**

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Do one of the following:
   - In the Review toolbar, click the Contours button and select the appropriate Contours tool (e.g., **Freehand**) from the dropdown list.
   - Right-click the active viewport and select the appropriate Contours tool (e.g., **Freehand**) from the popup menu.

3. Click and drag the mouse to draw or segment the ROI.

4. In the Propagate Contours group box, click the right (->) or left (<-) **Image** buttons to display the next image.

5. The application automatically propagates the contour on to the next image in the series.

6. Repeat **Step 4** to continue propagating the contour as required.

7. **Click Save**.

8. The application prompts you to save your markups.
9. Click OK.

**Note:** If you are using the 2D & MPR view, you must draw contours on each orthogonal plane to propagate them accordingly. You cannot propagate contours from the original orthogonal plane to the middle and left orthogonal planes.

## Using the RECIST Tool

This section describes how to use the RECIST tool. When you use the RECIST tool, you are measuring tumors using the target RECIST response criteria. The RECIST response criteria estimates the development of a tumor using the longest diameter (i.e., unidimensional). You can draw a maximum of ten RECIST lines. The RECIST tool calculates RECIST measurements taken on multiple images in multiple series, then displays them in the Measurements Results Table for comparison.

> **To measure a lesion using the RECIST tool**

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Do one of the following:
   - In the Review toolbar, click the RECIST button.
   - Right-click the viewport and select RECIST from the popup menu.
3. In the first series, click and drag the mouse over the lesion to mark the longest diameter. When you release the mouse button, the application displays the name of the layer (e.g., Tumor x, where x is the layer number).

4. The measurements for each RECIST created on the active layer automatically display in the Measurements Results Table. Measurements are itemized according to diameter (X value), perpendicular (Y value) and height (Z value). Position represents the spatial position of the image at the time of acquisition.

5. Repeat Step 3 to draw additional RECIST measurements on the second series.

6. You may, for example, want to delete and re-draw the Tumor 3 RECIST measurement. By default, the application increments the layer number of the next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the “Tumor 3” label, click Add Lesion in the Lesion group box and select the appropriate number from the dropdown list.

7. If desired, use the Active Layers dropdown list to draw RECIST measurements on a different layer (see “Working with Graphic Layers” on page 37).

8. Click Save.
9. The application prompts you to save your markups.

10. Click **OK**.

### Using the Crosshair Tool

This section describes how to use the Crosshair tool. When you use the Crosshair tool, you are measuring the tumor using the target WHO response criteria. The WHO response criteria uses two measurements to estimate the development of a tumor (i.e., bidimensional):

- the diameter of the tumor; and
- the perpendicular diameter of the tumor.

When you mark the longest diameter of the tumor using the Crosshair tool, the application automatically marks the perpendicular diameter of the tumor. You can draw a maximum of ten Crosshair lines. The Crosshair tool calculates WHO measurements taken on multiple images in multiple series, then displays them in the Measurements Results Table for analysis.

> **To measure a lesion using the Crosshair tool**

1. Load and display the patient series (see "Selecting and Loading Studies for Review" on page 21).

2. Do one of the following:
   - In the Review toolbar, click the Crosshair button.
   - Right-click the viewport and select **Crosshair** from the popup menu.
Chapter 7: Using the Lesion Analysis Tools

3. In the first series, click and drag the mouse over the lesion to mark the longest diameter. When you release the mouse button, the application automatically display the perpendicular diameter of the lesion and the name of the layer (e.g., Tumor x, where x is the layer number).

4. The measurements for each crosshair created on the active layer automatically display in the Measurements Results Table. Measurements are itemized according to diameter (X value), perpendicular (Y value) and height (Z value). Position represents the spatial position of the image at the time of acquisition.

5. Repeat Step 3 to draw additional crosshair measurements on the second series.

6. You may, for example, want to delete and re-draw the Tumor 3 crosshair measurement. By default, the application increments the layer number of the next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the “Tumor 3” label, click Add Lesion in the Lesion group box and select the appropriate number from the dropdown list.

7. If desired, use the Active Layers dropdown list to draw crosshairs on a different layer (see “Working with Graphic Layers” on page 37).

8. Click Save.
9. The application prompts you to save your markups.

![Image of save markup prompt]

10. Click **OK**.

**Using the Non-target Tool**

This section describes how to use the Non-target tool. When you use the Non-target tool, you are creating a focal point by drawing a non-measurable ellipse around a lesion.

**Note:** When using the Non-target tool in conjunction with graphic layers, the NT layer always remains active (see “To draw a non-target lesion using the Non-target tool” on page 57).

**Note:** Non-target lesions appear in the Measurements Results Table; however, their corresponding measurements are blank. The application does calculate the image position and displays corresponding values in the Position column.
To draw a non-target lesion using the Non-target tool

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Do one of the following:
   - In the Review Toolbar, click the non-target button.
   - Right-click the viewport and select Non-target from the popup menu.

3. In the first series, click and drag the mouse to draw an ellipse around the lesion. When you release the mouse button, the application displays the name of the NT layer (e.g., NT x, where x is the layer number).

4. The Measurements Results Table displays for each non-target object created on the active layer; however, diameter (X), perpendicular (Y) and height (Z) values remain blank. Position represents the spatial position of the image at the time of acquisition.
5. Repeat Step 3 to draw additional non-target measurements on the second series.

6. You may, for example, want to delete and re-draw the Tumor 3 non-target measurement. By default, the application increments the layer number of the next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the “Tumor 3” label, click Add Lesion in the Lesion group box and select the appropriate number from the dropdown list.

7. If desired, use the Active Layers dropdown list to draw non-target measurements on a different layer (see “Working with Graphic Layers” on page 37). When you draw a non-target measurement on the first layer (e.g., NT 1), then draw another non-target measurement on a second layer (e.g., NT 2), the non-target measurement on the first layer (e.g., NT 1) remains active. Measurements in both NT1 and NT2 layers appear active in the viewport.

8. Click Save.

9. The application prompts you to save your markups.

10. Click OK.
The example below displays an active non-target measurement on both NT and CSF layers. The CSF layer is the active layer; however, the NT layer always appears active. For details, see “Working with Graphic Layers” on page 37.

Navigating Measurements using the Measurements Results Table

You can use the navigation feature on the Measurements Results Table to navigate or “jump” to the associated measurement on the image.

> To navigate measurements

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Perform any of the procedures in “Measuring Lesions” on page 45 to measure lesions and display the Measurements Results Table for comparison.
3. In the Measurements Results Table, click the required Volume, RECIST, Crosshair or Non-target row to jump to the associated target measurement on the image.

**Note:** Non-target lesions also appear in the Measurements Results Table; however, their corresponding measurements columns are blank. The application does calculate the image position and displays corresponding values in the Position column.

### Exporting Measurements

After comparing volume, RECIST and crosshair measurements, you can export the Measurements Results Table in .txt file format to a local data source.

> **To export measurements**

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).

2. Perform any of the procedures in “Measuring Lesions” on page 45 to measure lesions and display the Measurements Results Table for comparison.

3. Click **Export**.

4. The Export Measurements dialog box displays.

5. Navigate to the appropriate local folder and type a file name.

6. Select from the available file types, i.e., Text files (.txt) or CSV files (.csv).
7. Click **Save**.

8. The application saves the measurements from the Measurements Results Table in the selected file format.

### Printing Measurements

After viewing volume, RECIST, crosshairs and non-target measurements, you can print the Measurements Results Table to a local or network printer.

> **To print measurements**

1. Load and display the required series (see “Selecting and Loading Studies for Review” on page 21).

2. Perform the required procedures to create volume, RECIST, crosshairs or non-target measurements (see “Measuring Lesions” on page 45).

3. Click **Print** and follow the instructions to print the output to the desired printer.
Chapter 8: Using the Review Tools

This chapter describes how to use the standard image review tools. Depending on the review tool you are using, you can access the tool:

• from the Review Toolbar (see “Using the Review Toolbar” on page 25);
• from the popup menu (see “Using the Popup Menu to Access Lesion Analysis and Review Tools” on page 25); and
• from the MPR Properties group box (“Changing the MPR Properties” on page 67).

Note: Throughout this document, we instruct you to select the appropriate review tool from the Review Toolbar. If the tool is unavailable from the Review Toolbar, we instruct you to use the popup menu.

Note: You can expand the Review Toolbar to access hidden review tools. To expand the Review Toolbar, click the Toolbar Options button.
Correlating the 2D & MPR Viewing Protocols

The Correlation Point Tool is the default tool selected in the Main Review window. By using this tool, you can triangulate all the MPR views to a single point that you click. You can select a cross-correlation point on any of the MPR viewports, or on the interactive volume viewport. The application automatically updates the cross-reference lines found in all the MPR viewports to reference the selected point.

> To correlate the 2D & MPR viewing protocols

1. Do one of the following:
   - In the Review Toolbar, click the Correlate button.
   - Right-click the viewport and select **Correlate** from the popup menu.
   - Press H on your keyboard to activate the Correlate Point tool.

2. Click a point on any of the viewports including the interactive volume viewport.

3. The application triangulates all the MPR views to the point that you have clicked.
Changing the MPR Properties

Using the tools in the MPR properties group box, you can define how images in 2D MPR Lesion view are displayed by adjusting the following properties:

- **Slice Thickness** — Increase/decrease the thickness of a slice.
- **Mode** — Project voxels into the rendered image.
- **Interpolation** — Resample the image using the available interpolation methods to enhance quality.

**Note:** When you change the properties on images displayed in the 2D & MPR viewing protocol, the application updates the images in all three orthogonal planes.

Use the following procedures to change the slice thickness, mode and interpolation properties.

**To change the slice thickness**

1. Load and display the patient series (see “Selecting and Loading Studies for Review” on page 21).
2. In the Slice Thickness field, type a value greater than one and Press ENTER on the keyboard.
3. The application updates the images based on the selected thickness value.
To change the mode

1. In the Mode dropdown list, select one of the following properties:
   - Average
   - Maximum Intensity Projection
   - Minimum Intensity Projection

   **Note:** Updates to the mode are only visible when the thickness is greater than 1 pixel.

To change the interpolation

1. In the Interpolation dropdown list, select one of the following properties:
   - Nearest Neighbour — Nearest neighbour in X, Y and Z planes.
   - Linear — Linear in X, Y and Z planes.
   - Linear Cubic — Linear in X, Y planes, cubic in Z plane.
   - Linear Nearest Neighbour — Nearest neighbour in X, Y planes, linear in Z plane.

To reset the properties

1. In the MPR Properties group box, click the **Reset** button.
2. The application resets the MPR properties to their default values.
Changing the Position of the Cross-Reference Lines

The cross-reference lines in each of the MPR viewports represent the image displayed in each viewport. On color monitors, the lines are color-coded where blue represents the left viewport, red represents the right viewport, and yellow represents the middle viewport.

You can view any position in the series by changing the position of the cross-reference lines. Since the change in view occurs in real time, it is referred to as “melting through” the images.

> To melt through the images using the cross-reference lines

1. Click on any cross-reference line and drag it to the desired position.

   ![Cross-reference Line]

   Cross-reference Line

2. The application updates the other viewports to reflect the new viewing plane.
> To melt through the images using the mouse-wheel

Note: By default, you can rotate your mouse-wheel to melt through images.

1. Make an MPR viewport active.
2. Rotate the mouse-wheel:
   • away from you to melt backward through the images; or
   • toward you to melt forward through the images.

> To melt through the images using a three-button mouse

Note: By default, the three-button mouse is configured to scroll images when you middle-click a viewport and move the mouse.

- Middle-click an MPR viewport and with the mouse button pressed and:
  • drag the mouse pointer up to scroll backward through the images; or
  • drag the mouse pointer down to scroll forward through the images.

Changing the Window Settings

The window settings (i.e., window width and window level) on digital images are similar to the contrast and brightness, respectively, on your computer screen. The window width can be wide (many grays, less contrast) or narrow (fewer grays, more contrast). The window level can be high (dark) or low (bright).

Note: You cannot change the window settings for color images.

You can adjust the window settings using the mouse or using presets.

The windowing operation is sensitive to the speed at which you move the mouse. If you move the mouse slowly, the window level changes will be relatively small. If you move the mouse more quickly, the changes will be relatively larger. Also, the changes will be relatively larger for higher resolution data.
> To change the window settings

1. In the Review Toolbar, click the Window button.
2. The mouse pointer displays as shown here.
3. Adjust the window width and/or level as follows:
   - click and drag the mouse vertically over the selected image to adjust the window level.
   - click and drag the mouse horizontally over the image to adjust the window width.

> To reset the window settings

1. In the Review Toolbar, click the Reset button.
2. The window width and/or level resets to their original values.

> To change the window settings preset

1. In the Review Toolbar, click the Window button and select Edit from the menu.
2. Select the required window present from the Manage Width\Level Presets dialog box.
3. Click Close.
> To change the window settings using the Auto Window/Level tool

1. In the Review Toolbar, click the Window Preset tool.
2. Select Auto Window/Level from the menu.

Defining Window Presets

You should define window presets for all window settings that you intend to use frequently. When you define a preset, it displays in the Window Presets list which is arranged alphabetically.

**Note:** There is a different Window Presets list for each study modality, therefore you must load a study of the appropriate modality before you can define or edit presets for that modality.

The application automatically saves the window presets you define according to your user name.

> To define a new window preset

1. In the Review Toolbar, click the Window button.
2. Use the mouse to adjust the window settings to the approximate values you want to define.
3. In the Review Toolbar, click the Window button and select Edit from the menu.

![Manage Width\Level Presets](image)

4. In the Manage Width\Level Presets dialog box, click New.
5. In the New (Edit) Width\Level Preset dialog box, the application displays the Width and Level values you applied in Step 2.

6. If required, adjust the Width and Level values.

7. Type a name for the preset in the Preset Name field.

8. Click Save.

> **To edit a window preset**

1. In the Review Toolbar, click the Window Presets button and select Edit from the menu.

2. Select the preset that you want to modify and click Edit.

3. Enter the required window width and level values.

4. Click Save.

> **To delete a preset from the list**

1. In the Review Toolbar, click the Window Presets button and select Edit from the menu.

2. Click the preset in the list that you want to delete.

3. Click Delete.
Zooming Images

You can zoom images and ROIs to examine them more closely.

> To zoom using the mouse

1. In the Review Toolbar, click the Zoom button. Alternatively, right-click the active viewport and select Disp. Area, and Zoom from the popup menu.

2. The mouse pointer displays as shown here. The Zoom tool is active as long as you have the mouse button pressed.

3. Click a point of interest on the image and drag the mouse vertically.

4. The application zooms to the point of interest.

> To zoom to an ROI

1. Right-click the active viewport and select Disp. Area, and Zoom to ROI from the popup menu.

2. The mouse pointer displays as shown here. The Zoom tool is active as long as you have the mouse button pressed.

3. Click and drag the mouse to identify the region of interest filling the entire viewport.

4. The application zooms to the region of interest

> To zoom to the cursor

1. Right-click the active viewport and select Disp. Area, and Zoom to Cursor from the popup menu.

2. The mouse pointer displays as shown here. The Zoom tool is active as long as you have the mouse button pressed.

3. Click and drag the mouse to zoom the full image.
Panning Images

You can pan or reposition the image within a viewport.

> To pan an image

1. In the Review Toolbar, click the Pan button. Alternatively, right-click the active viewport and select Disp. Area, and Pan from the popup menu.
2. The mouse pointer displays as shown here.
3. Click and drag the image to change its position in the viewport.

Changing the Scope

The scope is the range of displayed images to which the application applies your parameter changes (e.g., zooming, panning). You can choose one of three settings:

• Active Image — The application applies the changes to current image only (i.e., the image in the highlighted viewport).
• Series — The application applies the changes to the active series.
• All Images W/L — The window/level changes are applied to all loaded images.

> To change the scope

1. In the Review Toolbar, click the Scope button and select the appropriate scope setting from the menu (as described above).
2. The application changes the scope to the selected setting.
Magnifying Images

A magnifier is provided so that you can magnify specific areas of interest on the images. Only the images are magnified — overlay text, labels, etc., do not appear in the magnified area.

> To magnify a selected area in an individual image

1. In the Review Toolbar, click the Magnify button.
2. Click the area that you wish to magnify. Drag the mouse to magnify another area of interest.
3. The application displays the magnification factor at the top center of the magnification area.

**Note:** You can increase the magnification factor up to 6x by clicking the right mouse button while holding the left mouse button to after magnifying the area of interest.
Editing Measurements

This section describes how to edit (i.e., position, size) and delete lesion measurements drawn on an image. To edit the lines, you must select the layer that contains the lines you want to edit.

Editing RECIST, Crosshair and Non-target Measurements

Use the following procedures to edit measurements created using the RECIST Crosshair and Non-target tools.

> To resize a measurement
1. Click the measurement you want to resize.
2. The application displays grab handles at the end points of the selected measurement.
3. Click a handle or end point and drag it to resize the measurement.

> To reposition a measurement
1. Click the measurement you want to reposition.
2. Drag it to the appropriate position.

> To delete a measurement
1. Right-click the measurement you want to delete.
2. Select Delete from the respective popup menu.
To delete all measurements

1. Right-click the measurement you want to delete.
2. Select one of the following from the respective popup menus:
   - Delete All RECISTs — Only deletes RECIST measurements.
   - Delete All Crosshairs — Only deletes crosshair measurements.
   - Delete All Non-target Lesions — Only deletes non-target measurements.
Editing Contour Measurements

Use the following procedures to edit measurements created using the Contours tool.

> To hide a contour measurement

1. Right-click the contour you want to hide and select **Hide Measurements** from the popup menu.

![Hide Measurements]

2. The application hides the measurement.

> To show a contour measurement

1. If the contour’s measurements are hidden, right-click the contour whose measurements you want to show and click **Show Measurements**.

![Show Measurements]

> To edit the contour number

1. Right-click the contour whose number you want to edit and select **Edit Contour Number** from the popup menu.

![Edit Contour Number]

2. In the Edit Contour Index dialog box, edit the contour number in the text box provided.

![Enter Contour Index]

3. Click **OK**.
To delete a contour measurement

1. Right-click the contour you want to delete and select *Delete Object* from the popup menu.

2. The application deletes the measurement.

---

Querying the Density and Standard Uptake Value (SUV)

In the 2D and 2D & Lesion MPR views, you can query the density and Standard Uptake Value (SUV) of a specific point (pixel) on an image. The application can calculate the following:

- Body weight SUV (SUVbw) measured in g/ml.
- Tissue density for CT measured in Hounsfield Units (HU).

**WARNING:** The accuracy of the SUV query is dependent on the correctness of the values that you input as SUV related patient information, as well as other factors such as the origin of the data being queried. The SUV query output should be used only as a guideline for trend analysis.

To query the density of an image

1. In The Review Toolbar, click the Query Density/Standard Uptake Value button.

2. The mouse pointer displays as shown here.

3. Move the mouse pointer to a specific point of interest to display the pixel value.

**Note:** If the image is missing SUV attributes, the SUV value is displayed as “NA”.

---

CEDARA SOFTWARE
4. Move the mouse pointer to a specific point of interest.

Changing the Text Level

The text level is the level of information that the application displays in the image viewports, sometimes called the overlay text or image text. You can choose one of three levels.

None — Shows no information.

Basic — Shows only the basic text annotations.

Full — Displays the patient name, W/L settings, series ID, image ID and slice location.
> To change the text level

1. In The Review Toolbar, click the Select the text level button and select the desired text level from the dropdown menu.

Changing the Color Palette

You can change the color scheme applied to images displayed in the Main Review window. The application supports 8 color schemes.

![Color Palette Images]

- None (standard)
- NucMed Standard
- Reverse
- Reverse Hot Iron
- Hot Blue
- Thermal
- Hot Iron
- Rainbow
To apply a color palette

1. In the Review Toolbar, click the Color Palette button.

2. Select the required color palette from the menu. For a description of the available color palettes, see above.
A
accessing studies
  user permissions 19
adding, window presets 72
Analysis Review Page 25
anti-virus software 4
application
  exiting 18
  removing 14
  starting 17
  uninstalling 14
application port 13

B
brightness, changing window settings 70

C
cautions definition 6
color
  cross-reference lines 69
columns
  descriptions 20
compressed images, lossy 2
configuring 13
  regional settings 3
contact information 5
contours tool, using 46
contours, propagating 51
contours, creating
  automatically 49
  manually 47
contrast
  changing window settings 70
  field 4
conventions used in this guide 1, 5
correlation
  lines 69
creating
  window presets 72
crosshairs tool, using 54
cross-reference lines 69
customer support 5
customizing
  window presets 72

date format, configuring 3
defining
  window presets 72
definitions
  MPR 36
  notes, cautions, warnings 6
  thumbnails 26
deleting
  window presets 73
deleting contour measurements
  deleting 80
deleting lesion measurements
  deleting 77
desktop popup menu
  accessing viewing functions 25
distorted images 4

editing
  window presets 73
editing contour measurements
  contour number 79
  hiding 79
  showing 79
<table>
<thead>
<tr>
<th>Page</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>I-2</td>
<td>Cedara I-Response for NIH 2.0 User’s Guide</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>K</th>
<th>keyboard shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>logging on 17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th>language, configuring 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>left mouse button function 26</td>
</tr>
<tr>
<td></td>
<td>lesion analysis view</td>
</tr>
<tr>
<td></td>
<td>measuring lesions 45</td>
</tr>
<tr>
<td></td>
<td>lesions 45</td>
</tr>
<tr>
<td></td>
<td>level of text displayed</td>
</tr>
<tr>
<td></td>
<td>current setting 81</td>
</tr>
<tr>
<td></td>
<td>logging on 17</td>
</tr>
<tr>
<td></td>
<td>lossy compressed images 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
<th>magnetic interference 4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>magnifying images 76</td>
</tr>
<tr>
<td></td>
<td>markup management</td>
</tr>
<tr>
<td></td>
<td>graphic layers 41</td>
</tr>
<tr>
<td></td>
<td>user permissions 41</td>
</tr>
<tr>
<td></td>
<td>measurements</td>
</tr>
<tr>
<td></td>
<td>exporting 60</td>
</tr>
<tr>
<td></td>
<td>navigating 59</td>
</tr>
<tr>
<td></td>
<td>printing 61</td>
</tr>
<tr>
<td></td>
<td>measuring lesions</td>
</tr>
<tr>
<td></td>
<td>crosshairs tool 54</td>
</tr>
<tr>
<td></td>
<td>non target tool 56</td>
</tr>
<tr>
<td></td>
<td>melting through the images 69</td>
</tr>
<tr>
<td></td>
<td>middle mouse button</td>
</tr>
<tr>
<td></td>
<td>paging in Tile mode 33</td>
</tr>
<tr>
<td></td>
<td>minimum workstation requirements 7</td>
</tr>
<tr>
<td></td>
<td>mouse pointer 26</td>
</tr>
<tr>
<td></td>
<td>moving</td>
</tr>
<tr>
<td></td>
<td>images on the screen 75</td>
</tr>
</tbody>
</table>
MPR
melting through images 69
properties 67

Multiplanar Reformatting, see MPR

N
navigating
using the popup menu 25
using thumbnails 26
non target tool, using 57
number format, configuring 3

O
online help 18
online study list 20
column description 20
operating systems supported 8
overlay
image text 81

P
panning images 75
patient studies
selecting 27
viewing list of 20
PC requirements 7
popup menu
in the Analysis Review Page 25
positioning images 75
power failure 3
precautions 2
presets
window 71, 72

Q
quick access
Analysis Review Page functions 25
 quitting the application 18

R
RECIST tool, using 52
recommended workstation requirements 7
reformatting images
2D MPR view 36
regional settings 3
removing
window presets 73
removing, application 14
repositioning
images on the screen 75
requirements, workstation 7
review tools, using 65
reviewing images 65
right mouse click
in the Analysis Review Page 25
use in MPR View 69
RSI (repetitive strain injury) 2

S
safety precautions 2
scanner contrast field 4
scrolling images
standard 33
synchronized 34
scrolling, in 2D View 33
selecting
graphic layers 38
patient studies 27
viewing protocol 30
service contact information 5
showing or hiding graphic elements 40
software
  exiting 18
  exiting the application 18
  removing 14
  starting the application 17
  uninstalling 14
starting the application 17
studies
  accessing 19
  selecting 27
  using 19
supported operating systems 8
SUV
  querying 80

T
text level
  current setting 81
thumbnails
  navigating 26
toolbars
  Review Toolbar 25
tools
  lesion analysis 37
  review 65

U
uninstalling the application 14
upgrading the application 15
UPS (uninterruptible power supply) 3
user permissions
  markup management 41
  online study list 19
using the review tools 65

V
viewing protocols
  2D & MPR Lesion 36
  2D Lesion 31
  selecting 30
viruses 4

W
warning definition 6
wheel mouse
  melting through images 70
window
  presets 71, 72
  settings, changing 70
workstation requirements 7

Z
zooming images 74